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INTRODUCTION 
This publication is provided solely as a guide for individuals who have received 
Technical Training in servicing the METTLER TOLEDO product. 

For information, locate the closest authorized METTLER TOLEDO  
representative at the METTLER TOLEDO website  

www.mt.com

 
This manual correctly describes the operation and functionality of the IND130 
Terminal containing software versions as follows: 

Model Software Number Revision Date 

IND130 170338R 3.0 02/05 

    

    

 

http://www.mt.com/
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PRECAUTIONS 
• READ this manual BEFORE operating or servicing this equipment and FOLLOW 

these instructions carefully. 

• SAVE this manual for future reference. 
 

 
 

 

 WARNING! 
DISCONNECT ALL POWER TO THIS UNIT BEFORE INSTALLING, CLEANING, 
OR SERVICING. FAILURE TO DO SO COULD RESULT IN BODILY HARM 
AND/OR PROPERTY DAMAGE. 

 
 

 

 

 WARNING! 
DO NOT APPLY POWER TO THE IND130 TERMINAL UNTIL THE EXTERNAL 
WIRING AND THE INSTALLATION OF ALL COMPONENTS HAS BEEN 
COMPLETED. 

 

 CAUTION 
BEFORE CONNECTING/DISCONNECTING ANY INTERNAL ELECTRONIC COMPONENTS OR 
INTERCONNECTING WIRING BETWEEN ELECTRONIC EQUIPMENT ALWAYS REMOVE POWER 
AND WAIT AT LEAST THIRTY (30) SECONDS BEFORE ANY CONNECTIONS OR 
DISCONNECTIONS ARE MADE. FAILURE TO OBSERVE THESE PRECAUTIONS COULD RESULT 
IN DAMAGE TO OR DESTRUCTION OF THE EQUIPMENT AND/OR BODILY HARM. 

 
 

 CAUTION 
OBSERVE PRECAUTIONS FOR HANDLING ELECTROSTATIC SENSITIVE DEVICES. 

 
 

 

 WARNING! 
THE IND130 TERMINAL IS NOT INTRINSICALLY SAFE! DO NOT USE 
WITHIN AREAS CLASSIFIED AS HAZARDOUS DIVISION 1,2 OR ZONE 
0,1or2 BECAUSE OF COMBUSTIBLE OR EXPLOSIVE ATMOSPHERES.  

 
 
 

 

 

 WARNING! 
IF THIS DEVICE IS USED IN AN AUTOMATIC OR MANUAL FILLING CYCLE, 
ALL USERS MUST PROVIDE A HARD-WIRED EMERGENCY STOP CIRCUIT 
OUTSIDE THE DEVICE CIRCUITRY. FAILURE TO OBSERVE THIS 
PRECAUTION COULD RESULT IN BODILY INJURY AND/OR PROPERTY 
DAMAGE. 
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 WARNING! 
WHEN THIS EQUIPMENT IS INCLUDED AS A COMPONENT PART OF A 
SYSTEM, THE RESULTING DESIGN MUST BE REVIEWED BY QUALIFIED 
PERSONNEL WHO ARE FAMILIAR WITH THE CONSTRUCTION AND 
OPERATION OF ALL COMPONENTS IN THE SYSTEM AND THE POTENTIAL 
HAZARDS INVOLVED. FAILURE TO OBSERVE THIS PRECAUTION COULD 
RESULT IN BODILY HARM AND/OR PROPERTY DAMAGE. 

 
 
 

 

 WARNING! 
PERMIT ONLY QUALIFIED PERSONNEL TO SERVICE THE IND130 
TERMINAL. EXERCISE CARE WHEN MAKING CHECKS, TESTS, AND 
ADJUSTMENTS THAT MUST BE MADE WITH POWER ON. FAILING TO 
OBSERVE THESE PRECAUTIONS CAN RESULT IN BODILY HARM AND/OR 
PROPERTY DAMAGE.  

  
 
 

 

 

 WARNING! 
OUTPUTS ARE ALWAYS ACTIVE. DISABLE THE CONNECTED DEVICE(S) 
WHILE PERFORMING TERMINAL MAINTENANCE. FAILURE TO OBSERVE 
THIS PRECAUTION COULD RESULT IN BODILY INJURY AND/OR PROPERTY 
DAMAGE. 
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Chapter 1.0  
Introduction 

Thank you for purchasing a METTLER TOLEDO® IND130 Terminal. The 
IND130 combines simple operation with flexibility to enable use with a 
wide range of analog load cell scales while providing fast, digitally filtered 
responses to changes in weight. 

This manual provides information about the IND130 Terminal’s functions, 
configuration and programming, service and maintenance, installation, 
and connections. For further information about installation procedures, 
refer to the IND130 Terminal Installation Guide. 
This chapter covers 

• Overview 

• Physical Dimensions 

• Specifications 

• Operating Environment 

• Standards Compliance 
 

Overview 
The IND130 Terminal is a high-performance basic capability weighing instrument  
with a continuous RS-232 serial data output  or data exchange with Allen-Bradley 
RIO or PROFIBUS programmable logic control (PLC) interfaces. 

A configuration tool software program (PC Toolbox) is provided with the IND130 
and is used to configure, calibrate, and test the terminal. The configuration tool 
enables users to set up and calibrate the terminal features that affect weighing 
operation. In order to calibrate the terminal with the configuration tool, IND130 
toolbox software must be installed on a PC. The IND130 Terminal is then 
connected to the PC by an RS-232 serial data cable at a COM1 serial port. 

In addition, the PC may be used as a weight display when not in calibration mode. 

The IND130 Terminal is available with two enclosure styles: 

• DIN Rail Mount  
• Harsh Environment 
 
Six IND130 Terminal versions are available from the factory listed in Table 1-1. 

Table 1-1: IND130 Terminal Versions 

Order Number Enclosure PLC Interface 

IND13011 PROFIBUS 

IND13012 Allen-Bradley RIO 

IND13013 

DIN Rail Mount 

Serial only 

IND13021 PROFIBUS 

IND13022 Allen-Bradley RIO 

IND13023 

Harsh Environment

Serial only 
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DIN Rail Mount Enclosure 
The DIN rail mount version of the IND130 Terminal includes the following 
hardware features: 

• Plastic enclosure 

• Visible LEDs for indication of setpoint, zero tolerance, error reporting and status 
(see Fig.1-1) 

• Snap in mounting to a 35 mm steel top hat DIN rail. 

   Figure 1-1: LED Indicators (Profibus model shown) 

Zero Tolerance

Setpoint 1 

Error Reporting 

Status 

Harsh Environment Enclosure 
The Harsh Environment version of the IND130 Terminal includes the following 
hardware features: 

• Protective stainless steel enclosure UL tested to IP65 requirements. 

• Summing board for up to four analog load cells 

• Easily mounted to a wall or other mounting surface 
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IND130 Features 
Both Harsh Environment & DIN Rail Mount versions include the following features: 

Hardware Features 
• Isolated DC power from an optional 

external 24 VDC Class 2 supply 

• Removable screw terminal wiring 
connectors 

• Zero and tare weight power loss protection

• One optically isolated discrete input; two 
optically isolated open collector outputs 

• Serial port (RS-232) 

• Standard analog load cell support for 
up to four 350-ohm cells  

• Factory configured direct PLC 
connectivity to 

− Allen-Bradley RIO 

− PROFIBUS 

Software Features 
• Scale functions  

− CalFREETM calibration without test 
weights 

− 10,000 d (divisions) display resolution 

− Motion detection and indication 

• TraxDSP™ vibration rejection 
       -    Serial data functions 

− Continuous data output 

− Serial command input 

• Operator interface via serial port to 
the configuration tool 

− Consistent and intuitive 
operator interaction 

− Program block setup menu 

− Save/Load of configuration 
data 

• Memory Functions 

− Storage of zero and tare 
values during power-loss 
conditions 

− Storage of one setpoint value 
 

 Toolbox information button displays 

- Port speed status 
- Toolbox version 
- Installed main board 
- IND130 software version 
- Option card installed 
- Switch status 
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Allen-Bradley RIO Version 
The Allen-Bradley (A-B) RIO version consists of the IND130 with RIO interface with 
software that resides in the unit to implement the data exchange. This version 
supports bi-directional communications using the Discrete Data Transfer mode. 

The IND130 Terminal initiates a communication exchange with the PLC at every  
A-to-D weight update utilizing the Allen-Bradley Discrete Data Transfer protocol. 
This weight-synchronous communications is a high-speed, real-time message 
interface between the IND130 Terminal and PLC for process control. 

 Refer to the Allen-Bradley documentation or Allen-Bradley directly for questions 
related to the A-B RIO network such as cable length, number of nodes, and 
PLC model compatibility. 

PROFIBUS Version 
The IND130 Terminal communicates to a PROFIBUS L2-DP master according to  
DIN 19 245. The PROFIBUS option consists of a module and software that resides 
in the IND130 Terminal to implement the data exchange. 

 Refer to the PROFIBUS documentation or PROFIBUS International directly for 
questions related to the PROFIBUS module, such as cable length, number of 
nodes, and PLC model compatibility. 
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Physical Dimensions 
The IND130 Terminal Harsh Environment version is shown in Figure 1-2.  

Figure 1-2: IND130 Terminal Harsh Environment Version 

 
The IND130 Terminal DIN Rail Mount version is shown in Figure 1-3.  

Figure 1-3: IND130 Terminal DIN Rail Mount Version 
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Specifications 
Table 1-2: IND130 Terminal Specifications Table 

Specification DIN Rail Version Harsh Enclosure Version 

W × D × H 
50 × 140 × 103 mm 
(2.0 × 5.5 × 4.1 in.) 

300 × 128 × 89 mm 
(11.8 × 5.0 × 3.5 in.) 

Enclosure  
Plastic; Designed  

to meet IP20 
requirements  

Stainless steel; Dust-tight, 
splash-proof. UL approved 

for IP65 environments 

Power 
External 24 VDC 17 W listed Class 2 or 

 Certified “Limited Power Source” power supply 

Operating Environment 
–10° C to 40° C ( 14° F to 104° F) 

10 to 90% RH, non-condensing 

Storage Environment 
–40° C to 60° C (–40° F to 140° F) 

10 to 90% RH, non-condensing 

Scale Performance 
1,000,000 counts internal resolution 

Up to 10,000 counts external resolution 

Analog Scale Interface 
Up to four 350 ohm analog load cells 

5 volts excitation 

A/D Update Rate >300 Hz Internal; 20 Hz External (Serial and PLC I/F) 

Calibration 
Test weight calibration 

METTLER TOLEDO CalFREE operation 
(when used with qualified J-Box PCB) 

Filtering METTLER TOLEDO exclusive TraxDSP™ 

Discrete Inputs One optically isolated, positive true input for  
remote zero; Vmax = 30V; Imax = 10mA 

Discrete Outputs 
Two optically isolated, negative true open collector 

outputs for zero tolerance and setpoint status; 
Vmax = 30V; Imax = 30mA 

Serial Interface RS-232 supporting METTLER TOLEDO continuous 
output format and C,T, Z inputs 

PLC Interfaces 
Allen-Bradley Remote I/O, discrete mode 

Or PROFIBUS L2DP 

Optional Interface METTLER TOLEDO DeviceNET Module  
(requires connection to serial port) 

Approvals UL, cUL, CE marked 
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Controller PCB 
The IND130 Terminal’s COM1 serial port is an RS-232 transmission port. It also 
supports receipt of a single ASCII “C”, “T” or “Z” character for clear, tare, or zero. 

Connections to the terminal PCB are made using screw terminal strips. The wire 
size range for these terminal strips is 16 to 22 AWG. 

Standards Compliance 
• UL and cUL listing 
• Conducted and radiated emissions 
• CE European declaration (see certification in front portion of this manual) 

UL and cUL Listing 
The IND130 has been tested and complies with UL 60950-1-2003 1st edition. It is 
designed to CSA standard C22.2 No 60950-1-03 1st edition, Office Machines and 
carries UL and cUL labels.  

Conducted and Radiated Emissions  
The IND130 Terminal meets or exceeds FCC docket 80-284 for conducted and 
radiated emissions requirements as a Class A digital device. 

Radio Frequency Interference (RFI) Susceptibility 
The IND130 Terminal meets U.S., Canadian, and EC requirements for RFI 
susceptibility as listed in Table 1-3, with a maximum of one display increment of 
change when calibrated for recommended builds up to 6000e. 

Table 1-3: IND130 Terminal RFI Susceptibility 

RFI Susceptibility 

U.S.A./ Canadian EC Radio Reference 
Frequency Field Strength Field Strength 
27 MHz 3 volts/meter N/A 
169 MHz 3 volts/meter N/A 
464 MHz 3 volts/meter N/A 

27-1000 MHz N/A 10 volts/meter 
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For your notes



 

2-1 

This chapter covers 

• Configuration Tool 

• Configuration 

• Calibration 

Chapter 2.0  
Configuration and Calibration 

The IND130 Terminal connects to a PC to enable straightforward, efficient 
configuration, calibration, and testing of the terminal. PC Toolbox is the 
configuration tool software that enables terminal configuration and 
programming by a PC. The configuration tool program is provided on a 
CD-ROM with the IND130 Terminal. 

 

Configuration Tool 
The configuration tool is Windows-driven and includes a setup wizard that guides 
the user through the installation steps. In addition, the PC may be used as a weight 
display when not in calibration mode. The minimum PC system requirements are: 

• Windows 2000 or Windows XP operating system 

• Minimum monitor resolution of 800 x 600 with 16 bit color depth 

• COM1 serial port 

• A serial cable for the COM1 port for RS-232 signals RXD (receive), TXD 
(transmit), and GND (ground) to the IND130 

Software Installation 
To install the configuration tool software: 

1. Close all applications that are running on the PC 

2. Insert the CD-ROM that contains the PC Toolbox software in the PC’s CD drive. 
The installation menu will display (Figure 2-1). This menu provides links to the 
IND130 Terminal Technical/User Manual, the METTLER TOLEDO website, and a 
file for installing the Adobe Acrobat Reader.  

 If the installation menu does not display, use Window’s Explorer to open the 
Doccd/Maestro.exe file. 
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Figure 2-1: Configuration Tool Installation Menu 

3. Click the Install PC Toolbox button. If .NET Framework is not detected, the 
installation of .NET Framework begins. A window displays a message that .NET 
Framework installation is occurring. When complete, Setup Wizard is displayed. 

 The installation of .NET Framework can take five minutes or more. 

4. Click the Next button located in the lower-right corner of the Setup Wizard 
window. The next window for installing supporting tools is displayed. 

5. The Flash Magic tool can be installed by clicking the checkbox next to Install 
Flash Magic Tool and then clicking the Next button. The Flash Magic Tool 
enables reprogramming of the microchip in the IND130 Terminal. To prevent 
inadvertent reprogramming of the IND130 Terminal’s microchip, do NOT 
install Flash Magic. Instead, leave the checkbox next to Install Flash Magic 
Tool blank, and click only the Next button. The next window for selecting an 
installation folder is displayed. 

6. The default installation folder, c:/Program Files/Mettler Toledo/IND130 Toolbox 
displays as the selected installation folder. Click the Next button. The window 
for confirming installation is displayed. 

7. To complete the installation, click the Next button. The installation proceeds and 
completes automatically. 

Startup 
To open the configuration tool, click on: Start>Programs>Mettler Toledo>IND130 
Toolbox. The program launches in disconnected (offline) mode with the default file 
open and default settings active. To change the settings from the default values, 
open or create a new configuration file (see the Configuration section). 
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Navigation 
Use the menu bar, tool bar buttons, and menu tree (see Figure 2-2) to navigate 
within the configuration tool. 

 

 

 

 

 

 

 

 

 

 

 

Back button

Next button

Menu tree 

Tool bar buttons 

Menu bar 

Figure 2-2: Configuration Tool Main Window 

Menu Bar 
The following functions are available on the menu bar: 

• File 

− New—Enables the user to create a new configuration file for the IND130 
Terminal 

− Open—Opens an existing configuration file for the IND130 Terminal 

− Save—Saves the configuration data in the currently open file 

− Save As—Saves the configuration data to a file name entered or selected 
bythe user (file format is Extensible Markup Language (XML), which cannot 
be changed) 

− Exit—Closes the configuration tool 

• Terminal 

− Connect—Establishes the data connection between the IND130 Terminal 
and the configuration tool 

− Disconnect—Terminates the data connection between the IND130 Terminal 
and the configuration tool 

− Read Data from Terminal—Copies the configuration data from the IND130 
Terminal into PC working buffer. This buffer can be later saved to a PC file. 
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− Write Data to Terminal—Copies PC working buffer to the IND130 Terminal 

• Tools 

− Options—There are no options implemented for the IND130 

− PC Port Settings—Enables the selection of a COM port on the PC. All other 
data shown is for informational purposes only and cannot be modified. 

− Flash Magic—Launches the Flash Magic application if it was installed 
during the Configuration tool installation procedures. See the Software 
Installation section for further information about Flash Magic. 

• Help 

− ? Help—Launches a help file for the configuration tool 

− About—Opens a window that provides information about the configuration 
tool and the IND130 Terminal (if connected) 

Tool Bar Buttons 
The tool bar buttons are short cuts for implementing menu bar functions including: 

 File>New 

 File>Open 

 File>Save 

 Terminal>Read Data from Terminal 

 Terminal>Write Data to Terminal 

 Terminal>Connect 

 Terminal>Disconnect 

 Tools>PC Port Settings 

 Tools>Flash Magic 

 Help>? Help 

 Product Information 

 
Notes 
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Menu Tree 
The menu tree includes the following main branches: 

• Login—For use with future products. 

• Home—Displays a virtual operator panel that enables live weight viewing when 
the IND130 Terminal is connected (see Figure 2-3). Click on Home to display 
current weight readings. Click on the Tare, Tare Clear, or Zero buttons to perform 
these functions from the virtual operator panel. The Home branch has no 
function when the terminal is disconnected. 

• Setup—Contains the configuration navigation tree, which functions in 
connected or disconnected mode. The Next and Back buttons located near the 
lower-right corner of the window, a mouse pointing device, or the cursor keys 
can be used to navigate in the setup tree. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Information 
button 

Notes
button 

Product 
drop-down 
menu

Virtual 
operator 
panel 

Figure 2-3: Configuration Tool Virtual Operator Panel (Home in the Menu Tree) 
Status 

bar 

Other Configuration Tool Elements 
Other configuration tool elements (see Figure 2-2 for locations) and their functions 
are as follows: 

• Product Drop-Down Menu—Enables selection of the product to be configured. 
Version 1.0 of the PC Toolbox software only supports the IND130, so no other 
products are listed. 

•  Product Information Button—Opens a window that provides information 
about the configuration tool and the IND130 Terminal (if connected) or about 
the configuration tool only (if disconnected) 
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•  Notes Button—Opens a text box for recording information about the 
IND130 Terminal for which the configuration file is being created (for example 
the terminal’s location or serial number). This data is annotated to the 
configuration file when it is saved to PC file. 

 

• Status Bar—Displays the state of the configuration tool (connected or 
disconnected) and status of the serial port. The TX (transmit) and RX (receive) 
lights are active in the status bar when a corresponding connection is active. 

Connecting to the Terminal 
The configuration tool functions in two modes: 

• Connected—The mode of the configuration tool when it is actively 
communicating with an IND130 Terminal. 

• Disconnected—The mode of the configuration tool when it is offline and not 
communicating with an IND130 Terminal.  

IND130 Terminal and PC Connection 
The configuration tool communicates with the IND130 Terminal by an RS-232 
connection at 9600 baud, 8 data bits, 1 stop bit, and no parity. This port 
configuration is automatically established and cannot be altered by the user.  

Connect the IND130 Terminal to a PC that has had the configuration tool installed 
as described in the Software Installation section. Connect the terminal as follows: 

1. With the PC OFF, connect a serial data cable from the RS-232 connector on the 
terminal (see Figure 2-4) to the configured COM port on the PC. (Do NOT apply 
power to the IND130 terminal.) 

 If the COM port has been connected and power is applied to the terminal before 
or while the PC is booting, Windows will interpret the data from the terminal as 
serial mouse data and lock out the COM port on some computers. An error 
message displays if this situation occurs. When connecting the terminal, the 
power to the terminal, the serial data cable, or both should not be connected 
until after the PC has booted and is fully up and running. 

Figure 2-4: IND130 Terminal  

STA (Status) LED

RS-232 Connection 
(Profibus unit shown) 
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2. Turn on the PC. Wait until the PC has completed the booting process and 
Windows is fully up and running. 

3. Apply power to the terminal. The four LEDs on the front panel will flash a quick 
test pattern upon power up. The terminal is in operating mode when the STA 
(Status) LED (see Figure 2-4) flashes in a slow steady manner. 

4. Open the configuration tool by clicking on: Start>Programs>Mettler 
Toledo>IND130 Toolbox. 

5. Click the Connect button . The TX (transmit) and RX (receive) data 
indicators flash in the status bar at the lower-right corner of the configuration 
tool window. The lower-left status bar changes to “Terminal” to indicate that 
edits made while in connected mode will impact the connected IND130 
Terminal. 

6. A pop-up window displays with a reminder that the configuration data in the 
configuration tool memory might not match the configuration in the connected 
IND130 Terminal. The pop-up window asks “Read data from Terminal?”. If the 
configuration data is already edited as desired on the PC, click “No”. Otherwise, 
click “Yes” so that the PC memory and the target memory are synchronized. 

Connection Errors 
If terminal connection is unsuccessful, check for the following connection errors: 

• Serial cable connected improperly or miswired 

• Incorrect COM port selected on the PC Port Settings menu 

• COM port connected and power applied to the terminal before the PC completes 
the booting process. IMPORTANT!  IND130 power must be off while the PC is 
booting. IND130 Terminal switches incorrectly configured. Switch 2 (Factory 
Test) and Switches 3 and 4 (unused) must be OFF. See Appendix A, Installation 
for further information about switches. 

After correcting any connection errors, the PC must be off and IND130 unplugged 
and/or disconnected from the COM port. Follow steps 1 through 6 (do NOT skip any 
steps) under Connecting the Terminal. 

Connected Operation 
While connected to and exchanging data with the IND130 Terminal, users can  

• View live weight data using the virtual operator panel 

• Calibrate the IND130 Terminal 

• Change configuration settings  

• Read configuration data from the terminal and save it to a PC file 

• Write configuration data from a PC file to the terminal 
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Viewing Live Weight Data 
Live weight data can be viewed on the virtual console display when the IND130 
Terminal is connected to the PC. Click on Home in the menu tree to display current 
weight data (see Figure 2-3). Information shown on the virtual console display 
includes weighing units, weighing mode (gross or net), current tare value (T), and 
weight. While viewing live weight data, the user can also use the following buttons 
to perform the functions listed. 

• Tare—Sets the tare value to the current weight on the load cell 
• Tare Clear—Clears the current tare value 
• Zero—Sets the zero position of the load cell 

Calibrating the Terminal 
To accommodate a wider variety of load cell types, the IND130 Terminal includes a 
jumper to select one of two possible gain settings. The gain settings enable a 2 
mV/V or a 3 mV/V load cell to behave as though the outputs are identical. The 
analog to digital (A/D) converter in the terminal is factory calibrated for both 
gain settings, which makes all IND130 Terminal devices interchangeable. 

To ensure proper internal calibration, the jumper setting on the PCB (shipped from 
the factory in the 3 mV/V setting) must match the Gain Jumper setting selected 
using the configuration tool. This setting is made using the configuration tool menu 
tree to select Setup>Scale>Capacity and Increment. See the Configuration section for 
more information about how to set the Gain Jumper setting. 

For the best accuracy, calibrate the IND130 Terminal using certified test weights and 
the Capture Zero and Capture Span procedures that are available in the configuration 
tool menu tree. To access these procedures, select Setup>Scale>Calibration>Capture 
Zero and Setup>Scale>Calibration>Capture Span.  

If calibration with test weights is inconvenient or impossible, use the METTLER 
TOLEDO CalFREE process, which enables calibration without test weights. CalFREE 
is a method of mathematically calculating calibration factors based on the A/D 
converter gain setting, the load cell gain, and the desired scale capacity and 
increment size. Best results are achieved when the load cell gain factor is known to 
a high degree of accuracy. After performing a CalFREE computation, an on-site zero 
calibration can be performed to remove any zero balance error. 

Perform the CalFREE procedure by navigating in the calibration tool menu tree to 
Setup>Scale>Calibration>CalFREE. 

See the Configuration section for more information about calibration procedures with 
and without test weights. 

NOTE: If a load cell junction box is used with CalFREE, the box MUST NOT 
contain load cell trimming potentiometers. Any trimming pots in the load cell 
circuit will alter the individual load cell mv output preventing an accurate 
calibration.
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Changing Configuration Settings 
The IND130 configuration tool enables users to access and modify configuration 
settings. Save any configuration settings on the PC that will be needed in the future 
to a PC file before clicking on the Read data from Terminal button. Use the Setup 
section of the menu tree to navigate to the configuration parameters that are 
available for reconfiguration. Keep in mind that any configuration changes made 
while the IND130 Terminal is connected are updated in the local configuration tool 
memory as well as the configuration memory of the IND130 Terminal. 

See the Configuration section for further information about configuration parameters 
and associated settings. 

Reading Configuration Data From the Terminal 

When operating in connected mode, click the Read data from Terminal button  
to read the configuration data from the IND130 Terminal. The configuration settings 
will change to match those currently in effect on the terminal.  

Writing Data To the Terminal 

Use the Write data to Terminal button  to program the terminal with configuration 
data in a currently open or previously saved PC file. To write data to the terminal, open 
a previously created configuration file or establish the configuration settings desired in 
the currently open file. Click the Write data to Terminal button to change the terminal 
settings to match those in the open configuration file. 

Disconnected Operation 
When the configuration tool is in disconnected mode, the status bar displays “File” 
in the lower-left corner, which indicates that configuration settings made in this 

mode will only affect local PC files. The Connect button  in the tool bar at the 
top of the window is active (available) when the configuration tool is in 

disconnected mode, and the Disconnect button  is inactive (unavailable). 

IND130 Terminal configuration files can be created or edited in disconnected mode 
and saved to a PC file. Configuration settings must be written to the IND130 
Terminal in connected mode in order to implement them in the terminal’s 
operations. See the Connected Operation, Writing Data To the Terminal section. 

Configuration 
The Setup menu tree enables users to access configuration parameters that are 
available for reconfiguration and view parameters that cannot be changed. Click on 
the nodes listed under the main branches of the menu tree to navigate to the desired 
configuration setup parameters.  
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The Back button  and the Next button  also enable 
navigation in the setup menu tree. 

The Setup menu (Figure 2-5) enables configuration of parameters in four areas: 

• Scale • Communication  

• Application • Maintenance 

 
 

Figure 2-5: Setup Menu Tree 

Scale Configuration Parameters 
Scale configuration parameters include: 

• Capacity and Increment • Tare 

• Calibration • Filter 

• Zero • Stability 

 



IND130 Technical/User Manual 

2-11 

Capacity and Increment Parameters 
Use the Capacity and Increment setup (Figure 2-6) to select primary units, set the 
capacity and increment, and the Gain Jumper setting. 

Figure 2-6: Capacity and Increment Setup 

Primary Units 
Set the primary units from the drop-down menu selections, which include: 

• Pounds (lb) • Troy Ounces (ozt) 

• Kilograms (kg) • Pennyweight (dwt) 

• Grams (g) • Tonnes (t) 

• Ounces (oz) • Tons (ton) 

Capacity and Increment 
The units for setting capacity and increment change to match the primary units 
selected. To enter a new value for capacity, click in the text box. Use the keyboard 
to delete the value displayed and to enter a new value. To change the increment 
setting, use the drop-down menu to select the desired increment size. Increment 
sizes available will depend on the capacity selected. The largest available increment 
size is 50, and the smallest size is 0.001. 

Gain Jumper 
To ensure proper internal calibration, the jumper setting on the PCB (shipped from 
the factory in the 3 mV/V setting) must match the PC Toolbox Gain Jumper setting. 
If the PCB jumper has not been changed from the 3 mV/V factory setting, use the 
drop-down menu for the Gain Jumper setting to select 3 mV/V. If the PCB jumper 
has been changed to 2 mV/V, use the drop-down menu for the Gain Jumper setting 
to select 2 mV/V. If the toolbox gain setting does not match the IND130 PCB jumper 
position, an incorrect internal span and zero calibration will be used. 
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Calibration Parameters 
Calibration procedures include: 

• Capture Zero 
• Capture Span 
• CalFREE 

Capture Zero 
The capture zero procedure is an independent operation to reset the zero condition 
of the scale. To capture zero, make sure that the scale is empty, and click Capture 
Zero in the Setup menu tree. A status message “Start Calibration?” is displayed. 

Click the OK button to start the capture zero procedure.  

The status message reads “Capturing Zero! Please Wait…”. When the operation is 
complete, a final status message reads “Capture Zero Completed”, which verifies the 
successful completion of the capture zero operation. 

Capture Span 
The capture span procedure initiates a sequence to capture span (the difference 
between the highest and lowest calibration weight values). 

To capture span: 

1. Click Capture Span in the Setup menu tree. A status message “Place Test Load” 
is displayed. 

2. Place the test load weight on the scale. 

3. Enter the weight for the test load in the Test Load text box. The units displayed 
will match the primary units set in the Capacity and Increment settings. 

4. Click the OK button to start the capture span procedure. The status message 
reads “Capturing Test Load…” 

5. If the capture span operation was successful, a verification message that reads 
“Capture Span Completed” displays. If the capture span operation was not 
successful, an error message “Error! Capture Span failed” is displayed. 

 If an error occurs during the capture span operation, check for any 
problems with the test load weight on the scale or entered in the Test Load 
text box. Repeat steps 1 through 5. 

 Note: it is possible to calibrate the system with a test weight combination 
that would produce an overload condition if the full displayed capacity is 
applied. However, the software prevents more than approximately 55,000 
internal counts( approx 110% output capacity) before the out of range 
indication             is displayed. 



IND130 Technical/User Manual 

2-13 

CalFREE 
The METTLER TOLEDO CalFREE process enables calibration without test weights by 
mathematically calculating calibration factors based on the A/D converter gain 
setting, the load cell gain, and the desired scale capacity and increment size. 

Calculated calibration requires that both the load cell(s) and the A/D converter be 
independently calibrated and their output gains known. If multiple, similar load cells 
are mounted in parallel (typical for most multi-cell scales), the rated load cell 
output gain will be equal to the average of the load cell output gains. 

NOTE: If a standard calibration is performed, the CalFREE values will be overwritten. 

Before starting the CalFREE  process, make sure the toolbox gain jumper setting 
matches the physical jumper setting on the IND130 PCB. It they don’t match, a 
calibrated system without test weights is not possible 

To calibrate using the CalFREE process 

1. Click  CalFREE in the Setup menu tree. The CalFREE setup displays along 
with the status message “Calculate Calibration?” (Figure 2-7). The units 
displayed will match the primary units set in the Capacity and Increment 
settings. 

 

Figure 2-7: CalFREE Setup 

2. To enter new values for cell capacity, rated cell output, and estimated preload, 
click in the associated text boxes. If the preload value is unknown, do not enter 
a value at this time. Proceed and enter preload in a second pass calibration in 
step 6. Use the PC keyboard to enter a new value. Values in gray text boxes 
cannot be changed in CalFREE setup. Build capacity and gain jumper values 
must be changed in Capacity and Increment setup. 

3.  Calculate the “Rated Cell Output” value. That block must contain the AVERAGE 
combined output in millivolts/volt of all cells at full load cell rated capacity. This 
is calculated by adding all the millivolt ratings together and dividing by the 
number of cells. The individual rating is on each cell nameplate. Example for 4 
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cells in the system: Cell 1 = 2.0047mv/v, cell 2 = 1.9984 mv/v, cell 3 = 
2.1093 mv/v and cell 4 = 2.1239 mv/v. 

 Rated cell output = (2.0047+1.9984+2.1093+2.1239) / 4 = 2.059075. 
 Enter 2.059075 in the “Rated Cell Output” block. If only one load cell is used, 

simply enter the rated output of that cell. 

4. Click the OK button to start the CalFREE procedure.  

5. When CalFREE operation is complete, the verification message “Calibration 
values Saved” is displayed with updated values for Fine Span and Fine Zero. 

6. If the displayed weight is not zero when the scale is at a zero load condition, a 
preload value (scale initial) value is needed. Repeat the above process using 
the zero load value as the preload value. If the displayed value is within the 
zero capture range, simply “zero” the scale and bypass an additional CalFREE 
step.  

NOTE: The entered values are not saved, only the calculated calibration (Fine 
Span and Fine Zero) results. Also, If a load cell junction box is used with 
CalFREE, the box MUST NOT contain load cell trimming potentiometers. Any 
trimming pots in the load cell circuit will alter the individual load cell mv output 
preventing an accurate calibration. 

Zero Parameters 
There is only one selection available to reset the zero condition of a scale when 
small amounts of material are on the platform.  

• Ranges 

AZM and Display 
AZM is a means of maintaining “true zero” at all times on a digital scale but is 
disabled for the IND130. Figure 2-8 shows the AZM and Display setup selections. 

Power Up Zero is also Disabled 

OFF

Figure 2-8: AZM and Display Setup 

Auto Zero 
The auto zero function is set to off. This setting cannot be changed.    

Auto Zero Range 
The auto zero range is disabled. This setting cannot be changed. 
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Center of Zero 
The center of zero status is enabled. This setting cannot be changed. 

Blank Under Zero 
Blanking the display is used to indicate an under-zero condition when the terminal 
is in the Gross mode (no tare). Use the drop-down menu to enable or disable the 
under zero blanking. 

Ranges 
Use the drop-down menus (see Figure 2-9) to change the settings for pushbutton 
zero and the pushbutton zero range. 

Disabled 

Ranges 

Figure 2-9: Ranges Setup 

Pushbutton Zero 
If Pushbutton Zero is enabled, a discrete input or command from a PLC interface 
returns the scale to zero. 

Pushbutton Zero Range 
If Pushbutton Zero is enabled, use the Pushbutton Zero Range drop-down menu to 
set the range around the original zero condition for the scale within which 
Pushbutton Zero can be applied. The range setting can be either +/−2% or  
+/−20%. For example, if the Range setting for Pushbutton Zero is set at +/−2%, the 
Pushbutton Zero can only be used when the weight reading on the scale is at or 
below 2% of the original zero condition or when the weight reading on the scale is 
at or above –2% of the original zero condition. 
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Tare Parameters 
Tare is used to subtract the empty weight of a container or the weight of a container 
and the material inside from the gross weight on the scale to determine the net 
weight of the contents of a container. Tare is inhibited if the scale is in motion. 

Three setup selections are available to configure tare: 

• Types 
• Auto Tare 
• Auto Clear 

Types 
Use the Types setup selection to enable or disable tare. 

Tare 
Use the Tare drop-down menu to enable or disable the tare function. 

Auto Tare 
This function is set to disabled. It cannot be changed. 

Auto Clear 
This function is set to disabled. It cannot be changed. 

Filter 
The Filter setup selection enables the user to set a numeric value for the low pass 
filter frequency and to enable or disable the stability filter. 

Low Pass Frequency 
Enter the numeric data entry for the low pass filter frequency (0.1 through 9.9 Hz) 
by clicking in the text box and using the keyboard to enter the data. A lower corner 
frequency provides greater vibration rejection at the expense of a longer settling 
time. A higher corner frequency provides less vibration rejection with a faster settling 
time. If an invalid value is entered, a pop-up window displays with an invalid entry 
notification. 

Stability Filter 
The stability filter can be used to improve the readability of a static weight display 
by removing small variations in weight around a steady state value. If the stability 
filter is enabled and a “no-motion” condition is detected, a heavy filer is utilized, 
which keeps the display stable during slight changes in weight.  

If motion is detected while in this condition, the heavy filter is removed and the 
“normal” filter is used, which permits quick changes between stable weight 
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readings. The stability filter is normally used for static weighing applications. If the 
stability filter is enabled in dynamic applications, such as batching or filling, 
unrepeatable cutoff weights may result if the heavy filter switches in as the cutoff 
point is reached. 

Stability 
Use the Stability Filter drop-down menu to enable or disable stability filter function. 

Motion range 
Use the Motion Range drop-down menu to select the desired motion range or to 
disable motion detection. 

The motion detection feature determines when a scale platform no-motion condition 
exists. The sensitivity level determines what is considered stable. Stability detection 
occurs over a predefined period of time and allows a predetermined “acceptable” 
amount of motion in scale increments (d). Available settings are 1d or 3d. 
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Application Parameters 
Application parameters configures the functions that are externally controllable such 
as set points and discrete I/O.    

Operation 
The Operation setup selection includes: 

• Setpoints 
• Zero Tolerance 
• Print at Setpoint 

Setpoints 
A setpoint is an on/off output that indicates whether the weight displayed on the 
scale is greater than or less than a preprogrammed weight value. One setpoint 
weight can be set by clicking in the Setpoint text box and using the keyboard to 
enter the data. 

Zero Tolerance 
Zero tolerance is used as a control check to ensure that the scale has returned to 
within a preset incremental tolerance of zero before the next weighing operation may 
begin. Use the Zero Tolerance drop-down menu to select none, 1 increment, or 5 
increments for the zero tolerance setting. 

Print at Setpoint 
Printing at setpoint is permanently disabled. 

Input/Outputs 
The Input/Outputs setup selection enables viewing only of the settings for one 
discrete input and three outputs. 

Discrete I/O 
The discrete I/O settings are assigned by the terminal and data is provided for 
informational purposes only. They cannot be changed. 

I/O: Assignment: 

Output 1 Setpoint 1 

Output 2 Unused 

Output 3 Zero Tolerance 

Input 1 Zero 
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Communication  Parameters 
Communication configuration parameters include: 

• Connections 
• Serial 
• PLC 

Connections 
The Connections setup selection includes: 

• Checksum 
• STX 
• Protocol 

Checksum 
Checksum is used to detect errors in the transmission of data. Use the Checksum 
drop-down menu to enable or disable the checksum function. 

STX (Start of Text) 
The ASCII Start of Text character (02 hex) is always transmitted and cannot be 
disabled.  

Protocol 
The Protocol text box shows data for informational purposes only and indicates MT 
CONTINUOUS as the protocol. This setting cannot be changed. 

Serial 
The Serial setup selection enables viewing COM1 settings only. 

COM1 
The terminal is configured as COM1. The settings are assigned by the IND130 and 
cannot be changed. They are:  

Baud Rate: 9600 

Parity: None 

Data Bits: 8 

Stop Bits: 1 

PLC (Programmable Logic Control) 
The PLC setup selection enables the configuration of Allen-Bradley RIO or PROFIBUS 
PLC interfaces. The following selections display in the configuration tool: 
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• A-B RIO 
• PROFIBUS 

A-B RIO 
The Allen-Bradley Remote I/O (A-B RIO) network is an Allen-Bradley proprietary 
network that permits certain Allen-Bradley PLCs to communicate to additional racks 
of input and output devices or to other peripheral devices that implement the RIO 
interface. For more information about A-B RIO connections, refer to Appendix D, 
Allen-Bradley RIO Connections. 

The A-B RIO connection setup selections include: 

• Data Format • Last Rack? 

• Node Address • Data Rate 

• Start Quarter  

Data Format 
Data formats available include displayed weight without decimal point or Integer 
Divisions (total number of increments). Use the drop-down menu to select the 
desired data format. 

Node Address 
Each IND130 Terminal connected to the network represents one physical node; 
however, the addressing of the node is defined as a logical rack address. This 
address is determined by the system designer, then configured in the IND130 
Terminal by clicking in the Node Address text box and using the keyboard to enter 
the appropriate node address (0 – 64). When the node address is changed, the 
IND130 power must be cycled for the change to take effect. 

Start Quarter 
Each scale occupies a quarter rack in the RIO address space and the quarter may 
be defined as the first, second, third, or fourth quarter of a rack. Designate the 
location of the PLC that is the highest quarter used in a logical rack by using the 
drop-down menu to select the appropriate start quarter address (1 – 4). 

Last Rack? 
The IND130 configuration selections enable designation of the last rack. Use the 
drop-down menu to select Yes or No to designate a quarter rack in the RIO address 
space as the last rack. 

Data Rate 
Use the drop-down menu to select the desired data rate. Selections available are: 

• 57.6 K 
• 115.2 K 
• 230.4 K 
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PROFIBUS 
For more information about PROFIBUS connections, refer to Appendix E, PROFIBUS 
Connections. 

The PROFIBUS connection setup selections include: 

• Data Format 
• Node Address 

Data Format 
Data formats available include displayed weight without decimal point or Integer 
Divisions (total number of increments). Use the drop-down menu to select the 
desired data format. 

Node Address 
Each IND130 Terminal connected to the network represents one physical node. This 
address is determined by the system designer, then configured in the IND130 
Terminal by clicking in the Node Address text box and using the keyboard to enter 
the appropriate node address (0–126). When the node address is changed, the 
IND130 power must be cycled for the change to take effect. 

GSD File  
The GSD configuration file used with the PROFIBUS option is available on the 
IND130 CD, in the 917-0418-000 floppy disk kit, or down loadable from the 
PROFIBUS web site.     
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Maintenance Parameters 
Maintenance configuration parameters include: 

• Diagnostics – Scale 
• Reset All 

Diagnostics—Scale 
The Diagnostics—Scale setup selection includes: 

• Cell Output 
• Calibration Values 

Cell Output 
The Total Cell Output selection enables users to check the IND130 Terminal to 
ensure that the device is producing a data stream. To check the data stream using 
cell output: 

1. Use the View drop-down menu to select 

• Expanded Weight—Displays approx. 10 times the load cell output weight  
OR 

• Cell Output—Displays the actual load cell output 

2. Click on the Start button  to begin viewing the load cell output. 

3. Click on the Stop button  to terminate the cell output view. 

Calibration Values 
The Calibration Values selection enables users to view zero and span factors. These 
factors can be changed in the corresponding text boxes; however, changes to 
calibration values should NOT be made from this setup selection. 

Reset All 
The Reset All operation changes all configuration settings in the active file back to 
the factory default settings and deletes all calibration values. 

Click the OK button to start the Reset All procedure.  

When the Reset All operation initiates, a status message “Initializing to default…” 
displays. When the operation is complete, a verification message that reads “Reset 
Complete”  is displayed. 
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Saving Configuration Files 
When configuring the terminal settings in connected mode, configuration settings 
are automatically saved to the terminal when a navigation window is closed. In 
order to save settings to a PC file (in both connected and disconnected modes), the 
configuration settings must be saved to an existing file or saved as a new file.  

Configuration files created by the configuration tool are saved as Extensible Markup 
Language (XML) files. Do NOT change the file extension (.xml) to any other type of 
file extension. 

Click on the Notes button  to open a text box for recording information about the 
IND130 Terminal for which the configuration file is being saved (for example the 
terminal’s location or serial number). This data is annotated to the XML file when it 
is saved to the PC. 

Click on File>Save from the menu bar or on the Save button  in the tool bar to 
save configuration data in the currently open file. 

Click on File>Save As to save the configuration data to an existing file or to a new 
file created by the user. 
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This chapter covers 

• Cleaning and Maintenance 

• Service 

• Troubleshooting 

Chapter 3.0  
Service and Maintenance 

Regular maintenance inspections and service by a qualified service 
technician are recommended in order to optimize the operations of the 
IND130 Terminal. 

 
 
 

Cleaning and Maintenance 
For general cleaning, wipe the IND130 Terminal’s cover with a clean, soft cloth 
that has been dampened with a mild glass cleaner. Do NOT use any type of 
industrial solvent such as toluene or isopropanol (IPA), which could damage the 
terminal’s finish. Do not spray cleaner directly on the terminal. 

 
 

 

 WARNING! 
DISCONNECT ALL POWER TO THIS UNIT BEFORE, INSTALLING, CLEANING, 
OR SERVICING. FAILURE TO DO SO COULD RESULT IN BODILY HARM 
AND/OR PROPERTY DAMAGE. 

Service 
Only qualified personnel should provide service for the IND130 Terminal. Contact 
an authorized local METTLER TOLEDO representative for service assistance. 

 
 

 

 WARNING! 
PERMIT ONLY QUALIFIED PERSONNEL TO SERVICE THE IND130 
TERMINAL. EXERCISE CARE WHEN MAKING CHECKS, TESTS, AND 
ADJUSTMENTS THAT MUST BE MADE WITH POWER ON. FAILING TO 
OBSERVE THESE PRECAUTIONS CAN RESULT IN BODILY HARM AND/OR 
PROPERTY DAMAGE.  

Troubleshooting 
The IND130 Terminal is designed to be error-free and reliable. If problems do 
occur, ensure that the DC input power is within ±15% of the nominal 24 VDC input 
voltage.  

3-1 
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If the IND130 Terminal is malfunctioning, check the LED lights (Figure 3-1) to 
determine if the terminal is properly operating.  

Zero Tolerance

Setpoint  

Error Reporting 

Status 

Figure 3-1: IND130 Terminal LED Lights (PROFIBUS option shown)  

The LEDs and the indications associated with each when they are lit are listed in 
Table 3-1. 

Table 3-1: LED Lights and Indications 

LED Indication 

0 (Zero) 
Zero tolerance indication. (on when transmitted weight is 
within zero tolerance) 

SP (Setpoint) Setpoint status. (on when weight is below setpoint value) 

ERR (Error) Error indication (an error in terminal operation has occurred) 

STA (Status) 
Slow steady flash: Operating mode. Status is OK. 
Rapid flash: Incorrect switch setting. (eg: factory test sw. 2 on)

All LED Lights Light in rapid succession: IND130 powering up 
 
Attempt to determine the source of a problem prior to obtaining service. Record as 
much information as possible about what has happened including any error 
messages and physical responses of the terminal and/or scale. 

Troubleshooting Tips. 
1. intermittent connections to the Phoenix terminals is possible when wires 

are improperly inserted. Be sure screws are fully open when inserting wires 
as it is possible to install them on the wrong side of the clamp. 

2. Terminal continuity cannot be reliably measured with no wires installed. 
Screw continuity depends upon the clamp action of an inserted wire. 
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This chapter covers 

• Service Parts List 

Chapter 4.0  
Parts and Accessories 

This chapter provides information on service parts for the following IND130 
Terminal versions: 

• Harsh Environment—Serial 

• Harsh Environment—Allen-Bradley 

• Harsh Environment—PROFIBUS 

• DIN Rail Mount—Serial 

• DIN Rail Mount—Allen-Bradley 

• DIN Rail Mount—PROFIBUS 

Service Parts List 
Table 4-1 shows the service parts list for the IND130. 

Table 4-1: IND130 Service Parts List 

Item Description Order Number 

Replacement Main PCB 64054358 

Fuse 64055127 

Summing PCB 64055004 

PROFIBUS Connector 64054361 

24 VDC Power Supply 64053820 

Replacement Profibus PCB 68002075 

Replacement A-B RIO PCB 64055126 

 
 

4-1 
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This chapter covers 

• Inspection and Contents 
Checklist 

• Operating Environment 

• Terminal Connection 

• Controller PCB Switches 
and Jumper 

Appendix A  
Installation 

 
This appendix provides detailed information for installing the IND130 
Terminal.  

 
 
Locate the closest authorized METTLER TOLEDO representative at the 
METTLER TOLEDO website, www.mt.com. 

Inspection and Contents Checklist 
Prior to beginning the installation process, implement the following procedures: 

• Inspect the shipping container for damage.  

− If the shipping container appears damaged upon delivery, check inside for 
damage. File a freight claim with the carrier if necessary.  

− If the container is undamaged, unpack the container. Keep the original 
packing materials for future use.  

• Make sure the IND130 Terminal package contains the following: 

− IND130 Terminal (indicator) 

− Installation Installation Guide (paper copy) 

− Documentation CD-ROM  

Operating Environment 
The first IND130 Terminal installation step is to select the best location. Placing the 
IND130 Terminal in an appropriate location will enhance longevity and operation. 

 

 

 WARNING! 
THE IND130 TERMINAL IS NOT INTRINSICALLY SAFE! DO NOT USE 
WITHIN AREAS CLASSIFIED AS HAZARDOUS DIVISION 1,2 OR ZONE 0,1, 
or 2 BECAUSE OF COMBUSTIBLE OR EXPLOSIVE ATMOSPHERES.  

A-1 

http://www.mt.com/
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Keep in mind the following factors when choosing a location for the IND130 
Terminal: 

 

• The IND130 Terminal can be operated between a temperature range of 14° F 
to 104° F (−10° C to 40° C) at 10% to 90% humidity, non-condensing. 

• The IND130 Terminal is not intrinsically safe. However, the IND130 terminal 
is capable of operation with scales and barriers located in a hazardous area. 
Contact your authorized METTLER TOLEDO representative for assistance with 
hazardous area applications. 

 
 

 

 WARNING! 
DISCONNECT ALL POWER TO THIS UNIT BEFORE, INSTALLING, CLEANING, 
OR SERVICING. FAILURE TO DO SO COULD RESULT IN BODILY HARM 
AND/OR PROPERTY DAMAGE. 

Terminal Connection 
This section provides instructions for connecting the IND130 Terminal Harsh 
Environment and DIN Rail Mount enclosures. 

Terminal Connections for the Harsh 
Environment Version 

To connect the unit: 
1. Remove the six cover nuts from the enclosure (see Figure A-1). 

Screw

Back cover

Cable grips 

Figure A-1: IND130 Terminal Harsh Environment Enclosure (Closed) 
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2. Remove the cover to access the connection locations on the terminal. (See 
Figure A-2 for an open view of the Harsh Environment Enclosure and the 
location of the power and communication connections.) 

 

Junction box 
PCB 

Connection 
locations 

Figure A-2: IND130 Terminal Harsh Environment Enclosure (Open) 

3. Pass the cables that enter the enclosure through an appropriately sized cable 
grip before connecting the wires (see Figure A-1).  

4. Connect up to four 350-ohm load cells to the junction box PCB 
(See Figure A-3). 

Figure A-3: Junction Box PCB 

5. Connect the cabling to the terminal at the appropriate connection locations. 
(See Figure A-5 for each connection location.) 

6. Re-secure the cover with the six screws that were removed. 

7. Tighten the cable grip sufficiently to provide a water-tight seal around the 
cables. This will allow any internal cable slack to be received through the 
cable grip. 
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Terminal Connections for the DIN Rail 
Mount Version 
To mount the module, snap it onto the desired DIN rail. To dismount the module, 
retract the plastic module tab located on the bottom of the terminal with a 
screwdriver as shown in Figure A-4. 

Plastic retractable 
module tab. 

Figure A-4: Plastic Retractable Mounting Tab 

The IND130 Terminal DIN Rail Mount enclosure type uses an exposed terminal 
access design. All connections are made on the front panel of the terminal. 

Up to four 350-ohm load cells can be connected to the terminal by an external 
junction box available from METTLER TOLEDO (Model TB100801). A junction box 
WITHOUT potentiometers must be used if the CalFREE feature is utilized. 

If access inside the unit is necessary, gently push in on the tab slots with a flat-
head screwdriver. A quiet “pop” can be heard when the cover has been released.  

Making Connections 
This section provides instructions for making connections to the IND130 Terminal, 
including: 

• Electrical Connection 
• Load Cell Connection 
• Serial Port Connection 
• Discrete I/O Connections 
• Allen-Bradley RIO and PROFIBUS Options Connections 
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Figure A-5 shows the locations where connections are made on the terminal. 

     PROFIBUS
       connection 

RS-232 
connection I/O connections 

Figure A-5: Connection Locations (Profibus option shown) 

Electrical Connection 
In both the Harsh Environment and DIN Rail Mount version, connect power to the 
POWER terminal strip on the controller PCB (Figure A-5) from a 24VDC  class 2   
power source. Power terminal strip wiring is shown in Figure A-6. 

Power 
connection 

Load cell 
connection 

Ground
− (Common)

+24V

FigureA-6: Power Connection Wiring 

Power Requirements 
The IND130 Terminal must be powered by a 24 VDC Listed or recognized Class 2 
or certified LPS power supply. (A class 2 power supply is a current limited supply 
capable of withstanding a continuous short circuit without destruction). Use at 
least #18 AWG 300 volt wires for connections to class 2 and/or class 3 circuits. 

 
 

 

 WARNING! 
DISCONNECT ALL POWER TO THIS UNIT BEFORE INSTALLING, CLEANING, 
OR SERVICING. FAILURE TO DO SO COULD RESULT IN BODILY HARM 
AND/OR PROPERTY DAMAGE. 
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Load Cell Connection 
Procedures for making load cell connections are the same for the Harsh 
Environment and DIN Rail Mount enclosures. 

 CAUTION 
BEFORE CONNECTING/DISCONNECTING ANY INTERNAL ELECTRONIC COMPONENTS OR 
INTERCONNECTING WIRING BETWEEN ELECTRONIC EQUIPMENT ALWAYS REMOVE POWER 
AND WAIT AT LEAST THIRTY (30) SECONDS BEFORE ANY CONNECTIONS OR 
DISCONNECTIONS ARE MADE. FAILURE TO OBSERVE THESE PRECAUTIONS COULD RESULT 
IN DAMAGE TO OR DESTRUCTION OF THE EQUIPMENT AND/OR BODILY HARM. 

Cabling 
The maximum cable length for load cell connections to the IND130 Terminal 
depends on the total scale resistance (TSR) of the scale base. To calculate TSR: 

Load Cell Input Resistance (ohms) 
TSR = 

Number of Load Cells 

 
The IND130 Terminal can power up to four 350-ohm analog load cells. 
Table A-1 lists the recommended cable lengths based on TSR and cable gauge. 

Table A-1: Recommended Maximum Cable Length 

TSR (Ohms) 24 Gauge 
(feet/meters) 

20 Gauge 
(feet/meters) 

16 Gauge 
(feet/meters) 

350 800/244 2000/610 4000/1219 

87 (4-350 Ω cells) 200/61 600/183 1000/305 
 
 Connect the appropriate length of cable to the LOADCELL terminal strip of the 
IND130 Terminal (see Figure A-5). The pinout for the LOADCELL terminal strip is 
labeled on the bottom of the controller. Figures A-7, A-8, and A-9 show the 
IND130 Terminal LOADCELL terminal strip wiring for standard six-wire cable, 
heavy capacity (MASSTRON) six-wire cable, and standard four-wire cable. 

 NOTE: Colors shown at right and in subsequent 
load cell cable lists are typical and do not 
represent all load cells. There are many 
variations with no defined standard. Actual 
colors vary. 

−EXC 7  Blue 

−SEN 6  Red 

−SIG 5  Black 

Shield 4  Orange 

+SIG 3  Green 

+SEN 2  Yellow 

+EXC 1  White 

 

 

Figure A-7: Wiring for Standard Six-Wire Cable 
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−EXC 7 Black 

−SEN 6 Blue 

−SIG 5 Red 

Shield 4 Yellow 

+SIG 3 White 

+SEN 2 Brown 

+EXC 1 Green 

Figure A-8: Heavy Capacity (MASSTRON) Six-Wire Cable 

−EXC 

−SEN 

7 
6 

  
 
  

Black 

−SIG 5  Red* 

Shield 4  Yellow or Orange 

+SIG 3  White* 

+SEN 
+EXC 

2 
1 

    
 

 
Green 

*If an increase in load results in a decrease in weight  
  display, reverse the signal wires (+SIG and −SIG). 

Figure A-9: Standard Four-Wire Cable 

Minimum Increment Size for Scale Input 
The minimum increment size selection for an analog scale input is determined by 
calculating the microvolts per increment for the desired build. To calculate the 
microvolts per increment, use the following equation: 

Increment Size × Cell Output × 5000 
µV per increment =

Load Cell Capacity × Ratio 
The increment size, scale capacity, and load cell capacity must all be measured in 
the same weight units (lb or kg). If the weight units for any of these variables are 
listed in kg units, multiply by 2.2046 to convert to lb units for the purposes of this 
calculation. 

Load cell output is rated in millivolts per volt of excitation (mV/V) and is marked on 
load cell data tag. METTLER TOLEDO load cells are typically 2 mV/V. Other load 
cells can range from 1 mV/V to 4.5 mV/V.  

The load cell capacity is the rated capacity marked on the load cell data tag. The 
ratio is the total number of load cells in the system or the total lever ratio (if the 
scale is a mechanical lever system conversion). 
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Sample Calculation 
The following example of µV per increment calculation for a four load cell scale 
installation is provided as a reference. 

Use the following formula to calculate the µV per increment: 

Increment Size × Cell Output × Excitation (mV/V) 
µV per increment =

Load Cell Capacity × Ratio 
 

The scale parameters are as follows: 

Scale Capacity  5000 lb 
Increment Size 1.0 lb 
Load Cell Capacity 2500 lb 
Number of Cells 4 
Cell Output 2 mV/V 
Excitation Voltage 5 VDC 

 
Using these parameters in the formula 

1.0 lb × 2 mV/V × 5000 
µV per increment =

2500 lb × 4 Load Cells 
= 1.0 µV per increment 

 
The IND130 Terminal acceptable weighing performance can be obtained with a 
minimum of 0.25 µV per increment. At full scale, the maximum load cell output 
must not exceed 10 mV when the W1 jumper is in the 2 mV/V position or 15 mV 
when the W1 jumper is in the 3 mV/V position. 

Serial Port Connection 
The COM1 serial port is bi-directional. It can receive simple commands or serial 
target data, as well as transmit data to a printer or other serial device. Figure A-5 
shows the location of the RS-232 terminal strip for serial port connections. The 
communications are fixed at 9600 baud, 8 data bits (no parity) and 1 stop bit. 
They cannot be changed. The ASCII input characters are limited to “C”, “T” and “Z” 
(single character with no CR) 

Figure A-10 shows the IND130 Terminal block COM1 pin-to-pin cable connections 
using an RS-232 cable. The maximum recommended cable length for RS-232 
communications is 50 feet. 
 

COM1  

1 RSGND   Signal Ground 

2 RSRXD   RS-232 Receive 

3 RSTXD   RS-232 Transmit 

4 NC  Keyed pin 

Figure A-10: COM1 Connections 
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Discrete I/O Connections 
See Figure A-5 for the location of the I/O (labeled DIGITAL OUT and DIGITAL IN) 
terminal strips. Refer to the Appendix B, Inputs and Outputs for additional 
information on discrete I/O functions. 

DIGITAL IN  

4 NC  Keyed pin 

5 IN-  Common (GND) 

6 IN+  Momentary +24VDC to zero terminal 

Figure A-11: Digital Input Connections 

DIGITAL OUT  

1 PULL-UP  +5 to +24VDC 

2 NC  Not used 

3 OUT1  Announce Setpoint 1 Status 

4 OUT2  Not used 

5 OUT3  Announce Zero Tolerance Status 

6 OUT GND Common (GND) 

Figure A-12: Digital Output Connections 

Allen-Bradley RIO, PROFIBUS Optional Connections 
The Allen-Bradley RIO interface requires a three-pin Phoenix plug (provided). The 
PROFIBUS connection requires a special male 9-pin D subminiature connector (not 
provided) See Figure A-5 for location. The PROFIBUS connector may be ordered 
through METTLER TOLEDO. Refer to Refer to Appendix D, Allen-Bradley RIO 
Connections and Appendix E, PROFIBUS Connections, for more information. 
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Controller PCB Switches and Jumper 
 

Figure A-11 shows the location of the controller PCB switches and jumper. 

SW1 Switch

W1 Jumper

Figure A-13: Main Controller PCB 
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Switches 

The SW1 switch settings are shown in Table A-2. 

Table A-2:  SW1 Switch Settings 

Switch Function 

1 Access Control (must be on to modify setup) 

2 Factory Test Mode (must be off) 

3 No function (must be off) 

4 No function (must be off) 

Gain Jumper 
The W1 gain jumper setting on the PCB can be either 2 mV/V or 3 mv/V. The 
terminal is shipped from the factory in the 3 mV/V setting. The jumper settings are: 

• 2 mv/V—Jumper installed on both pins 
• 3 mv/V—Jumper removed 
 

This jumper setting must be the same as the selection made during configuration. 

 

Connector layout 
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This appendix covers 

• RS-232 Serial I/O 

• Discrete I/O Reference 

• Setpoint Mode 

Appendix B  
Inputs and Outputs 

 
This appendix provides information about the IND130 Terminal’s inputs 
and outputs. 

 

 

RS-232 Serial I/O 
The IND130 Terminal transmits continuous serial data at the RS-232 Serial I/O 
port. The RS-232 connection is 9600 baud, 8 data bits, no parity, 1 stop bit. This 
port configuration is automatically established and cannot be altered. This data 
consists of 16 or 18 bytes transmitted in a 10-bit ASCII frame consisting of: 1 start 
bit, 8 data bits, no parity bit, and 1 stop bit. The format is shown in Table B-1: 

The continuous serial data output is also used by the configuration tool when a PC 
is connected. It automatically switches back to continuous when the IND130 
Terminal is connected to another remote device. 

An ASCII Start of Text (STX) and a checksum character may be added to the data 
output if desired. The checksum character is defined as the 2’s complement of sum 
of the 7 least significant bits of all preceding characters including the <STX> and 
<CR> (dropping all bits that carry past the 7 least significant bits). The checksum 
character is transmitted with the same parity as all other characters. The checksum 
is supported, but may be optionally configured as “off”, in which case the 
character is not sent. 

Table B-1: Serial Data Output Format 

Character Function 
 

Character Function 

1 STX (Start of text—Optional) 
 

10 Weight LSD 

2 Status Word A 
 

11 Tare Weight MSD 

3 Status Word B 
 

12 Tare Weight 

4 Status Word C 
 

13 Tare Weight 

5 Weight MSD 
 

14 Tare Weight 

6 Weight 
 

15 Tare Weight 

7 Weight 
 

16 Tare Weight LSD 

8 Weight 
 

17 CR (carriage return) 

9 Weight 
 

18 CKSM (Checksum—Optional) 
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Non-significant weight data and tare data digits will be transmitted as spaces. 
Status words A, B, and C descriptions are shown in Tables B-2, B-3, and B-4. 

Table B-2: Continuous Mode Status Word A    Table B-3: Continuous Mode  
            Status Word B 

 

Bit Status Word A 

Encoded Decimal Point 

Display Bit 2 Bit 1 Bit 0 

XXXXX0 0 0 1 

XXXXXX 0 1 0 

XXXXX.X 0 1 1 

XXXX.XX 1 0 0 

0,1,2 

XXX.XXX 1 0 1 

3 1 = or greater than setpoint  
0 = less than setpoint  

4 Always = 1 

5 Always = 1 

6 Always = 0 

7 Always = 0 

 
*If bit 4 =0 and Sw C bits 0-2 are not 0 then units = alternate units. 
 
Table B-4: Continuous Mode Status Word C 

 

Bit Status Word B 

0 Gross=0, Net=1 

1 Minus sign = 1 

2 Overcap = 1 

3 Motion = 1 

4* lb = 0, kg = 1 

5 Always = 1 

6 Within zero 
tolerance = 0 

7 Always = 0 

Bit Status Word C 

*Alt 
units 

lb g t oz 
 

ozt dwt ton 

*0 0 1 0 1 0 1 0 

*1 0 0 1 1 0 0 1 

*2 0 0 0 0 1 1 1 

3 Print = 1 

4 Always = 1 

5 Always = 1 

6 Always = 1 

7 Always = 0 
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Serial Input 
The IND130 terminal has an RS232 input mode that allows simple commands to 
be received.  All characters must be uppercase with no control characters such as 
STX, CR and LF.  All other ASCII characters are ignored. It recognizes the following 
commands.  

 ASCII 
Command 

Function Description 

C Clear Clear tare value to gross mode 

T Tare Tare scale to zero  

Z Zero Zero scale (if within range and no-motion) 

 

 
 
 
 
  

 

Discrete I/O Commands 
The IND130 Terminal has one discrete input and two available discrete outputs. 
The open collector discrete outputs require a +5 to 24 VDC reference and can sink 
up to 30 mA maximum. 

To activate the input, apply +5 to 24 VDC to the input terminal. Input function is 
edge triggered and must be held at positive true for at least 100 ms. The only 
command available via the discrete input is Zero. 

Discrete I/O terminal block assignment considerations include: 

• All discrete outputs are open collector circuits, common emitter 
• Discrete input levels are  

− VIN LOW = 0.0 to + 0.8 VDC   
− VIN HIGH = +3.5 to +24 VDC 
 

The 2 outputs and 1 input are assigned the following functions: 

OUT1 Setpoint 1 

OUT2 Unused 

OUT3 Zero Tolerance 

IN+ Zero  

IN- Logic common 
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Setpoint Mode 
The setpoint outputs are negative true and "ON" when the scale weight is below the 
setpoint value and “OFF” when equal to or above the setpoint value. The setpoint 
operates on the absolute value of the scale weight so it can be used for both 
weigh-in and weigh-out processes. The setpoint is ENABLED at power up. 

Interlocks and/or relay logic are not included with the IND130 Terminal. If 
start-stop logic is required, METTLER TOLEDO recommends purchasing this 
hardware (and design) through an authorized local METTLER TOLEDO 
representative. 

 
 

 

 WARNING! 
WHEN THIS EQUIPMENT IS INCLUDED AS A COMPONENT PART OF A 
SYSTEM, THE RESULTING DESIGN MUST BE REVIEWED BY QUALIFIED 
PERSONNEL WHO ARE FAMILIAR WITH THE CONSTRUCTION AND 
OPERATION OF ALL COMPONENTS IN THE SYSTEM AND THE POTENTIAL 
HAZARDS INVOLVED. FAILURE TO OBSERVE THIS PRECAUTION COULD 
RESULT IN BODILY HARM AND/OR PROPERTY DAMAGE. 

 
 
 

 

 

 WARNING! 
IF THIS TERMINAL IS USED IN AN AUTOMATIC OR MANUAL FILLING 
CYCLE, ALL USERS MUST PROVIDE A HARD-WIRED EMERGENCY STOP 
CIRCUIT OUTSIDE THE TERMINAL CIRCUITRY. FAILURE TO OBSERVE THIS 
PRECAUTION COULD RESULT IN BODILY INJURY AND/OR PROPERTY 
DAMAGE. 

 
 
 

 

 

 WARNING! 
OUTPUTS ARE ALWAYS ACTIVE. DISABLE THE CONNECTED DEVICE(S) 
WHILE PERFORMING TERMINAL MAINTENANCE. FAILURE TO OBSERVE 
THIS PRECAUTION COULD RESULT IN BODILY INJURY AND/OR PROPERTY 
DAMAGE. 

B-4 



 

This appendix covers 

• IND130 default settings 

Appendix C  
Default Settings 

 
When the configuration tool is opened, the default file opens and the 
default settings for configuration setup are active. Table C-1 lists the 
configuration tool default settings. 

Table C-1: Configuration Tool Default Settings 

Setup Group Configuration Parameter Default Setting 

Scale 
 Capacity and  
      Increment 

 
Primary Unit 
Increment 
Gain Jumper 

 
lb 
100 lb x 0.01 lb 
3 mV/V 

 Calibration Capture Zero 
Capture Span 
CalFREE 

No Settings—Used to 
implement calibration 
procedures 

 Zero AZM and Display 
 Auto Zero 
 Auto Zero Range 
 Blank Under Zero 

Ranges 
Power up Zero 
Power up Range 

 “Pushbutton” Zero 
 “Pushbutton” Zero  

 
Off * 
0.5 d * 
Disabled 
 
Disabled * 
+/−2% * 
Enabled 
+/−2% 

 Tare Types 
 Tare 
 Auto Tare 
Auto Clear Tare 

 
Enabled 
Disabled* 
Disabled* 

 Filter Low Pass Frequency 
Stability Filter 

2.0 Hz 
Disabled 

 Stability Motion Range 1 d (divisions) 

Application 
 Operation 

 
Setpoints 

 
 Setpoint 
 Zero Tolerance 
 Print at Setpoint 

 
 
0.00 
None 
Disabled* 

 Input/Outputs Discrete I/O 
 OUT1 
 OUT2 
 OUT3 
 In+ 

 
Setpoint 1* 
Unused* 
Zero Tolerance* 
Zero* 
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Setup Group Configuration Parameter Default Setting 

Communication 
 Connections 

 
Checksum 
STX (Start of Text) 
Protocol 

 
Disabled 
Disabled* 
MT Continuous* 

 Serial COM1 
 Baud Rate 
 Parity 
 Data Bits 
 Stop Bits 

 
9600* 
None* 
8* 
1* 

 PLC (Optional) A-B RIO (Allen-Bradley) 
 Data Format 
 Node Address 
 Start Quarter 
 Last Rack? 
 Data Rate 
PROFIBUS 
 Data Format 
 Node Address 

 
Display Increments 
001 
1 
Yes 
115.2 K 
 
Display Increments 
001 

Maintenance 
 Diagnostics 

 
Scale 
Cell Output 
View 
Expanded Weight 
 Calibration Values 
  Zero 
  Span Factor 

 
 
 
Expanded Weight 
000000 # 
 
0 
0.1000000 

 Reset All  No Settings—Used to reset 
default settings 

*Settings displayed for informational purposes. These settings cannot be modified.  
# = Updated by start/stop functions
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This appendix covers 

• Interface PCB Wiring 

• Status Lights 

• Setup in the IND130 Terminal 

• Discrete I/O Control 

• Data Definition 

Appendix D  
Allen-Bradley RIO 
Connections 

 
This appendix provides information about the IND130 Terminal 
Allen-Bradley RIO version connections. 

 

 
 
 

 

 WARNING! 
OUTPUTS ARE ALWAYS ACTIVE. DISABLE THE CONNECTED 
DEVICE(S) WHILE PERFORMING TERMINAL MAINTENANCE. 
FAILURE TO OBSERVE THIS PRECAUTION COULD RESULT IN 
BODILY INJURY AND/OR PROPERTY DAMAGE. 

Interface PCB Wiring 
The IND130 Terminal Allen-Bradley RIO interface PCB wiring uses a three wire 
connector. The Allen-Bradley “blue hose” cabling is wired left to right as Blue, 
Shield, Clear. 

Status Lights 
The Allen-Bradley (A-B) option 
board has a status LED with three 
modes: 

ON normal operation 
Flashing PLC in Program Mode 
OFF PLC Communication problem 

Setup In the IND130 Terminal 
To configure the IND130 Terminal for an A-B RIO PCB, select 
setup>Communication>PLC>A-B RIO from the configuration tool menu tree. 
Configure data for the following options: 

• Data Format— Select Displayed integer weight (decimal point ignored) or  
Integer Divisions  

• Node Address—Enter the appropriate node address (0 – 64) 
• Start Quarter—Designate quarter used in a logical rack by selecting the 

appropriate start quarter address (1 – 4) 
• Last Rack?—Select Yes or No to designate a quarter rack in the RIO address 

space as the last quarter of the rack 
• Data Rate—Select the desired data rate: 
− 57.6 K 
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− 115.2 K 
− 230.4 K 

Communications 
The Allen-Bradley Remote I/O (RIO) network is a proprietary network that permits 
certain A-B PLCs to communicate to additional racks of input and output devices or 
to other peripheral devices that implement the RIO interface. The IND130 Terminal 
utilizes component parts that are provided by A-B thereby ensuring complete 
compatibility with the RIO network. An IND130 Terminal is recognized as an A-B 
device by the PLC. Each IND130 Terminal connected to the RIO network represents 
a physical node.  

The connection is facilitated by a three-position removable terminal block on the 
IND130 Terminal RIO option back panel. The terminal block is labeled 1, SHLD, 
and 2. These terminals correspond to the like terminals on the A-B PLC RIO 
connector. The wiring between the PLC and the IND130 Terminal RIO connector 
uses the standard RIO cable supplied by A-B. This cable is often referred to as the 
"blue hose." The cable installation procedures and specifications are the same as 
recommended by A-B for the RIO network. 

Node Address 
Although each IND130 Terminal RIO option represents one physical node, the 
addressing of the node is defined as a logical rack address. This address is 
determined by the system designer, then programmed into the IND130 Terminal. 
Programming is done through the configuration tool using the 
Communication>PLC>A-B RIO program block in Setup. 

Each scale occupies a quarter rack in the RIO address space and the quarter may 
be defined as the first, second, third, or fourth quarter of a rack. It is also necessary 
to designate the location of the PLC that is the highest quarter used in a logical 
rack. The IND130 Terminal’s programming capabilities enable selection of the 
starting quarter and designation of the last rack. (See the Setup In the IND130 
Terminal section for further setup information.) 

NOTE: When the node (rack) address is changed, the IND130 power must be 
cycled for the address change to take effect. 

Discrete I/O Control 
The IND130 Terminal provides I/F cannot directly control the discrete outputs. It 
reads its discrete input via the (digital) PLC interface options. The IND130 
Terminal’s discrete I/O updates are synchronized with the IND130 A/D rate, not 
with the PLC I/O scan rate. This factor may cause a noticeable delay in reading 
inputs or updating outputs as observed from the PLC to real-world signals. 
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Data Definition 
The IND130 Terminal A-B RIO I/O network supports Discrete Data Transfer that 
enables bi-directional communication of discrete bit encoded information or 16-bit 
binary word (signed integer) numerical values. Each IND130 represents a quarter 
rack of data to the RIO option and each quarter rack provides two input (read) and 
two output (write) words. A quarter logical rack has 32 input bits (two 16-bit 
words) and 32 output bits (two 16-bit words). The data in these input and output 
words is formatted as shown in Table D-1. 

Table D-1: Discrete Read—IND130 Terminal Output to PLC Input 

Bit Numbers Word 0 Word 1 

0 Integer Weight bit 00 Setpoint 15

1 Integer Weight bit 01 Not Used 

2 Integer Weight bit 02 Zero Tolerance6

3 Integer Weight bit 03 Not Used 

4 Integer Weight bit 04 Not Used 

5 Integer Weight bit 05 Not Used 

6 Integer Weight bit 06 Not Used 

7 Integer Weight bit 07 Not Used 

8 Integer Weight bit 08 Not Used 

9 Integer Weight bit 09 PAR 1.11  (zero) 

10 Integer Weight bit 10 Not Used 

11 Integer Weight bit 11 Not Used  

12 Integer Weight bit 12 Motion2

13 Integer Weight bit 13 Net Mode2

14 Integer Weight bit 14 Update in Progress3

15 Integer Weight bit 15 Data OK4

 

1. PAR 1.1 is the current state of the IND130 Terminal discrete “zero” input (1=zero). 
2. Positive true (1=True) 
3. If 1, the IND130 Terminal was updating the PLC interface shared memory while data 

was read. The PLC should ignore this data and rescan. 
4. Set to 1 if scale is operating properly, not over or under range, in power-up, expanded 

mode, or in setup mode. (Integer weight will be set to zero.) 
5. Setpoint 1 output bit status 
6. Zero Tolerance output bit status 
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Table D-2: Discrete Write—PLC Output to IND130 Terminal Input 

Bit Numbers Word 0 Word 1 

0 Integer tare/Setpoint Bit 00 Select 11

1 Integer tare/Setpoint Bit 01 Select 21

2 Integer tare/Setpoint Bit 02 Select 31

3 Integer tare/Setpoint Bit 03 Load Preset Tare2,7

4 Integer tare/Setpoint Bit 04 Clear Tare Command3,8

5 Integer tare/Setpoint Bit 05 Pushbutton Tare Command3,7

6 Integer tare/Setpoint Bit 06 Not used 

7 Integer tare/Setpoint Bit 07 Zero Command3

8 Integer tare/Setpoint Bit 08 Enable Setpoint Command4,5

9 Integer tare/Setpoint Bit 09 Not Used 

10 Integer tare/Setpoint Bit 10 Not Used 

11 Integer tare/Setpoint Bit 11 Not Used 

12 Integer tare/Setpoint Bit 12 Not Used 

13 Integer tare/Setpoint Bit 13 Not Used 

14 Integer tare/Setpoint Bit 14 Not Used 

15 Integer tare/Setpoint Bit 15 Load Setpoint Value6

 

1. A binary value in bits 0-2 select the data in Discrete Read weight data source:  
0 = Gross weight, 1 = Net weight, 2 = Displayed weight, 3 = Tare or active Target if in 
Over/Under mode, 4 = Setpoint 1, 5-7 = Gross. 

2. A 0 to 1 transition causes the value in Word 0 to be written into the preset tare register. 
3. A 0 to 1 transition activates the command. 
4. Setpoint high level outputs are disabled if this bit is set = 0, enabled if set = 1. Setting 

this bit to 1 after a downloaded Setpoint value will store the downloaded value in non-
volatile memory. It must be set = 0 to cause setpoint target register to be written. See 6 
to update memory.  

5. A value =1 must be written here for PLC to assume control of setpoint enable. 
 NOTE: Both PLC and IND130 toolbox can write a setpoint value. The IND130 is 

setpoint enabled at power up. 
6. A 0 to 1 transition causes the value in Word 0 to be written into IND130 memory, 

however, the non-volatile memory Setpoint target register will not be updated unless 
the Enable Setpoint Command bit = 1. The Word 0 value for Setpoint 1 or Target 1 is 
in the primary unit (calibrated unit). 

7. When tare interlocks are set, accumulative tares will not be permitted. 
8. When tare interlocks are set, tare can only be cleared at gross zero. 
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This appendix covers 

• Wiring 

• Setup in the IND130 
Terminal 

• Discrete I/O Control 

• Data Definition 

Appendix E  
PROFIBUS Connections 

 
This appendix provides information about the IND130 Terminal 
PROFIBUS version connections. 

 
 
 

 

 WARNING! 
OUTPUTS ARE ALWAYS ACTIVE. DISABLE THE CONNECTED 
DEVICE(S) WHILE PERFORMING TERMINAL MAINTENANCE. FAILURE 
TO OBSERVE THIS PRECAUTION COULD RESULT IN BODILY INJURY 
AND/OR PROPERTY DAMAGE. 

Wiring 
The PROFIBUS connection is a female 9-pin D subminiature connector, which is 
the PROFIBUS standard connection. The field connector assembly is not supplied 
with the IND130. This connector may be purchased from METTLER TOLEDO. The 
wiring for the connector is as follows: 

1 GND (isolated) 
2 N.C. 
3 TX/RX+ 
4 RTS 
5 GND (isolated) 
6 +5V (isolated) 
7 N.C. 
8 TX/RX- 
9 N.C. 

Setup In the IND130 Terminal 
To configure the IND130 Terminal for a PROFIBUS PCB, select 
Setup>Communication>PLC>PROFIBUS from the configuration tool menu tree. 
Configure data for the following options: 

• Data Format— Select Display Increments (decimal point implied) or Integer 
Divisions (no decimal point implied) 

• Node Address—Enter the appropriate node address (0 – 126) 
NOTE: When the node address is changed, the IND130 power must be cycled 
for the address change to take effect. 
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Data Definition 
The IND130 Terminal PROFIBUS PLC Interface supports Discrete Data Transfer that 
enables bi-directional communication of discrete bit encoded information or 16-bit 
binary word (signed integer) numerical values. The data in these input and output 
words is formatted as shown in Table E-1. 

Table E-1: Discrete Read—IND130 Terminal Output to PLC Input 
 

Bit Numbers Word 0 Word 1 
0 Integer Weight bit 00 Setpoint 5

1 Integer Weight bit 01 Not Used 

2 Integer Weight bit 02 Zero Tolerance6

3 Integer Weight bit 03 Not Used 

4 Integer Weight bit 04 Not Used 

5 Integer Weight bit 05 Not Used 

6 Integer Weight bit 06 Not Used 

7 Integer Weight bit 07 Not Used 

8 Integer Weight bit 08 Not Used 

9 Integer Weight bit 09 Zero1

10 Integer Weight bit 10 Not Used 

11 Integer Weight bit 11 Not Used 

12 Integer Weight bit 12 Motion2

13 Integer Weight bit 13 Net Mode2

14 Integer Weight bit 14 Update in Progress3

15 Integer Weight bit 15 Data OK4

 

1. Zero is the current state of the IND130 Terminal “zero” input. 
2. Positive true (1=True) 
3. If 1, the IND130 Terminal was updating the PLC interface shared memory while data 

was read. The PLC should ignore this data and rescan. 
4. Set to 1 if scale is operating properly, not over or under range, in power-up, expanded 

mode, or in setup mode (Integer weight will be set to zero.) 
5. Setpoint output bit status 
6. Zero Tolerance output bit status 
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Table E-2: Discrete Write—PLC Output to IND130 Terminal Input 

Bit Numbers Word 0 Word 1 

0 Integer tare/Setpoint Bit 00 Select 11

1 Integer tare/Setpoint Bit 01 Select 21

2 Integer tare/Setpoint Bit 02 Select 31

3 Integer tare/Setpoint Bit 03 Load Preset Tare2,7

4 Integer tare/Setpoint Bit 04 Clear Tare Command3,8

5 Integer tare/Setpoint Bit 05 Pushbutton Tare Command3,7

6 Integer tare/Setpoint Bit 06 Print Command3

7 Integer tare/Setpoint Bit 07 Zero Command3

8 Integer tare/Setpoint Bit 08 Enable Setpoint Command4,6

9 Integer tare/Setpoint Bit 09 Unused 

10 Integer tare/Setpoint Bit 10 Unused 

11 Integer tare/Setpoint Bit 11 Unused 

12 Integer tare/Setpoint Bit 12 Unused 

13 Integer tare/Setpoint Bit 13 Unused 

14 Integer tare/Setpoint Bit 14 Unused 

15 Integer tare/Setpoint Bit 15 Load Setpoint Value5

 

1. A binary value in bits 0-2 select the data in Discrete Read weight data source:  
0 = Gross weight, 1 = Net weight, 2 = Displayed weight, 3 = Tare or active Target if in 
Over/Under mode, 4 = Setpoint 1, 5-7 = Gross. 

2. A 0 to 1 transition causes the value in Word 0 to be written into the preset tare register. 
3. A 0 to 1 transition activates the command. 
4. Setpoint outputs are disabled if this bit is set = 0, enabled if set = 1. Setting this bit to 

1 after a downloaded Setpoint value will store the downloaded value in non-volatile 
memory. It must be set = 0 to write to the setpoint target register. See note 5 to update 
memory. 

5. A 0 to 1 transition causes the value in Word 0 to be written into IND130 terminal 
memory, however, the non-volatile memory Setpoint target register will not be updated 
unless the Enable Setpoint Command bit = 1. The Word 0 value for Setpoint 1 or 
Target 1 is in the primary unit (calibrated unit). 

 
6. A value = 1 must be written for PLC to assume control of setpoint enable. 
 
 
NOTE: Both PLC and IND130 toolbox can write a setpoint value. The IND130 is setpoint 

enabled at power up. 
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PROFIBUS GSD 
or Type Files 

The IND130 Terminal PROFIBUS GSD files are available free of charge. They can be 
ordered from METTLER TOLEDO in a kit PN 0917-0418, which also includes a .200 type 
file for ET200 applications. The GSD file can also be downloaded free of charge from the 
PROFIBUS website: www.profibus.com. 
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Appendix F  
Glossary 

 

Auto Clear When auto clear is enabled, the tare is automatically 
cleared when the scale returns to the center of zero. 

Auto Tare When auto tare is enabled, the tare weight is taken 
automatically when weight is on the scale. 

Auto Zero When auto zero is enabled, automatic internal corrections 
for offsets and/or drift at zero input are applied. 

Blank Under Zero When blank under zero is enabled, the display becomes 
blank to indicate an under-zero condition when the 
terminal is in the Gross mode (no tare). 

CalFREE A method of mathematically calculating calibration factors 
based on the A/D converter gain setting, the load cell gain 
(sensitivity), and the desired scale capacity and increment 
size. 

Capacity Maximum amount of weight that can be placed on a scale 

Extensible Markup 
Language (XML) 

A widely used system for defining data formats. XML 
provides a powerful system to define complex documents 
and data structures. 

Increment The value of the finest division of a scale 

Low Pass Filter An electronic network for passing low and attenuating high 
frequencies. 

Motion Range A predetermined “acceptable” amount of motion in scale 
increments (d) used to determine when a no-motion 
condition exists on the scale platform. The sensitivity level 
determines what is considered stable. 
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Node Address Each unit connected to a remote I/O (RIO) network 
represents one physical node. The node address is a 
logical rack address that is determined by the system 
designer. 

Pushbutton Zero When pushbutton zero is enabled, auto zero can be 
implemented by pushbutton. 

Setpoints Setpoints are on/off outputs that indicate whether the 
weight displayed on the scale is greater than or less than 
a preprogrammed weight value. Setpoints are typically 
used in material filling applications in order to fill a 
container to a preset weight.  

Span The difference between the highest and lowest calibration 
weight values. 

Stability Filter A filter that can be used to improve the readability of a 
static weight display by removing small variations in 
weight around a steady state value. 

Tare Tare is the empty weight of a container. Tare is normally 
used to determine the net weight of the contents of a 
container.  

Tare interlocks A set of restrictions on how tare can be used that are 
required by some local weights and measures regulations. 
If tare interlocks are enabled, the terminal must be at 
gross zero to clear a tare weight. 

Virtual Operator Panel A panel that displays in the active window of the 
configuration tool that enables live weight viewing when 
the terminal is connected to the PC. 

Zero Zero is the empty weight of the scale platform or 
weighbridge. The gross zero reference is recorded during 
calibration. Also see AZM. 

Zero Tolerance Zero tolerance is used as a control check to ensure that 
the scale has returned to within a preset incremental 
tolerance of zero before the next weighing operation may 
begin. 
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14001

 Quality certification. Development, 
production, and auditing in accordance w
ISO9001. Environmental management 
system in accordance with ISO14001. 
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Worldwide service. Our dense service 
network, among the best in the world, 
ensures the maximum availability and 
lifespan of your product. 
 
Conformité Européene 
This label is your guarantee that our 
products conform to the latest guidelines. 
 
On the Internet. You can find important 
information about our products and 
services, as well as our company, quickly 
and easily at http://www.mt.com 
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